Omnesys Technologies Private Limited.

NEST
An ECO system for securities

User Manual For Retailers
Proprietary Notice

This document contains confidential information of Omnesys Technologies Pvt Ltd, which is provided for the sole purpose of permitting the recipient to evaluate the deployment document submitted herewith. In consideration of receipt of this document, the recipient agrees to maintain such information in confidence and to not reproduce or otherwise disclose this information to any person outside the group directly responsible for evaluation of its contents, except that there is no obligation to maintain the confidentiality of any information which was known to the recipient prior to receipt of such information from Omnesys Technologies Pvt Ltd, or becomes publicly known through no fault of recipient, or is received without obligation of confidentiality from a third party owing no obligation of confidentiality to Omnesys Technologies Pvt Ltd.
## Table Of Contains

<table>
<thead>
<tr>
<th>Menus/Option</th>
<th>Page no</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1- File Menu</strong></td>
<td></td>
</tr>
<tr>
<td>1.1 Login</td>
<td></td>
</tr>
<tr>
<td>1.2 Logout</td>
<td></td>
</tr>
<tr>
<td>1.3 Refresh Clients</td>
<td>9-13</td>
</tr>
<tr>
<td>1.4 Get Log Messages</td>
<td></td>
</tr>
<tr>
<td>1.5 Delete Scrip File</td>
<td></td>
</tr>
<tr>
<td>1.7 Log Info</td>
<td></td>
</tr>
<tr>
<td>1.8 Exit</td>
<td></td>
</tr>
<tr>
<td><strong>2- Market</strong></td>
<td>14</td>
</tr>
<tr>
<td>2.1 Market Watch profile</td>
<td>14-41</td>
</tr>
<tr>
<td>2.1.1 Buy Order Entry</td>
<td>14</td>
</tr>
<tr>
<td>2.1.2 Sell Order Entry</td>
<td>14</td>
</tr>
<tr>
<td>2.1.3 Order Book</td>
<td>15-17</td>
</tr>
<tr>
<td>2.1.4 Trade Book</td>
<td>17-20</td>
</tr>
<tr>
<td>2.1.5 Create Basket-Buy</td>
<td>20</td>
</tr>
<tr>
<td>2.1.6 Create Basket-Sell</td>
<td>21</td>
</tr>
<tr>
<td>2.1.7 Actions</td>
<td>22</td>
</tr>
<tr>
<td>2.1.8 Act On call</td>
<td>22</td>
</tr>
<tr>
<td>2.1.9 Tools</td>
<td>22-31</td>
</tr>
<tr>
<td>2.1.10 User Defined Column</td>
<td>31-32</td>
</tr>
<tr>
<td>2.1.11 Dialog Bars</td>
<td>32-38</td>
</tr>
<tr>
<td>2.1.12 Cover Order</td>
<td>38</td>
</tr>
<tr>
<td>2.1.13 Bracket Order</td>
<td>38</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>2.1.14</td>
<td>Security Alert</td>
</tr>
<tr>
<td>2.1.15</td>
<td>Intraday Chart</td>
</tr>
<tr>
<td>2.1.16</td>
<td>Historical Chart</td>
</tr>
<tr>
<td>2.1.17</td>
<td>The Windows Horizontally</td>
</tr>
<tr>
<td>2.1.18</td>
<td>The Windows Vertically</td>
</tr>
<tr>
<td>2.1.19</td>
<td>Gridlines</td>
</tr>
<tr>
<td>2.1.20</td>
<td>Write To Excel</td>
</tr>
<tr>
<td>2.1.21</td>
<td>Link To Excel</td>
</tr>
<tr>
<td>2.1.22</td>
<td>Customized</td>
</tr>
<tr>
<td>2.1.23</td>
<td>Refresh Market watch scrip</td>
</tr>
<tr>
<td>2.1.24</td>
<td>Subscribe For this Group</td>
</tr>
<tr>
<td>2.1.25</td>
<td>Subscribe On Check</td>
</tr>
<tr>
<td>2.1.26</td>
<td>Add My Holdings</td>
</tr>
<tr>
<td>2.2</td>
<td>Market Watch Group Settings</td>
</tr>
<tr>
<td>2.3</td>
<td>Load Pre-defined Market Watch</td>
</tr>
<tr>
<td>2.4</td>
<td>Snap Quote</td>
</tr>
<tr>
<td>2.5</td>
<td>VWap Statistics</td>
</tr>
<tr>
<td>2.6</td>
<td>Combined Market Depth</td>
</tr>
<tr>
<td>2.7</td>
<td>Security List</td>
</tr>
<tr>
<td>2.8</td>
<td>News</td>
</tr>
<tr>
<td>2.8.1</td>
<td>Add Tab</td>
</tr>
<tr>
<td>2.8.2</td>
<td>Delete</td>
</tr>
<tr>
<td>2.8.3</td>
<td>Hide Story</td>
</tr>
<tr>
<td>2.9</td>
<td>Nest Notification</td>
</tr>
<tr>
<td>2.10</td>
<td>Search &amp; Add Contracts</td>
</tr>
<tr>
<td>2.11</td>
<td>Price Ladder</td>
</tr>
<tr>
<td>2.12</td>
<td>Market Monitor</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### 3- Orders and Trades

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.1-</td>
<td>Basket Orders</td>
<td></td>
</tr>
<tr>
<td>3.1.1-</td>
<td>Normal basket</td>
<td>52-55</td>
</tr>
<tr>
<td>3.1.2-</td>
<td>Balanced Basket</td>
<td>55-56</td>
</tr>
<tr>
<td>3.1.3-</td>
<td>Direct Basket</td>
<td>56-57</td>
</tr>
<tr>
<td>3.1.4-</td>
<td>Spread Basket</td>
<td>57-58</td>
</tr>
<tr>
<td>3.1.5-</td>
<td>Add/Delete/Edit customized Basket</td>
<td>58-59</td>
</tr>
<tr>
<td>3.1.6-</td>
<td>Customized Basket Order Entry</td>
<td>59</td>
</tr>
<tr>
<td>3.2-</td>
<td>Model Basket</td>
<td>60-61</td>
</tr>
<tr>
<td>3.2.1-</td>
<td>Add/Delete/Edit Model Basket</td>
<td></td>
</tr>
<tr>
<td>3.2.2-</td>
<td>Model Basket order Entry</td>
<td></td>
</tr>
<tr>
<td>3.3-</td>
<td>After Market Orders</td>
<td>61-62</td>
</tr>
<tr>
<td>3.3.1-</td>
<td>Buy order Entry</td>
<td></td>
</tr>
<tr>
<td>3.3.2-</td>
<td>Sell Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.3.3-</td>
<td>Basket order</td>
<td></td>
</tr>
<tr>
<td>3.4-</td>
<td>Buy Order Entry</td>
<td>62</td>
</tr>
<tr>
<td>3.5-</td>
<td>Sell Order Entry</td>
<td>63</td>
</tr>
<tr>
<td>3.6-</td>
<td>Cover Order entry</td>
<td>63-64</td>
</tr>
<tr>
<td>3.6.1-</td>
<td>Buy Cover Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.6.2-</td>
<td>Sell Cover Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.7-</td>
<td>Bracket Order Entry</td>
<td>64-66</td>
</tr>
<tr>
<td>3.7.1-</td>
<td>Buy Bracket Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.7.2-</td>
<td>Sell bracket Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.8-</td>
<td>Trigger Order Entry</td>
<td>66-69</td>
</tr>
<tr>
<td>3.8.1-</td>
<td>Buy Trigger Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.8.2-</td>
<td>Sell Trigger Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.9-</td>
<td>Smart Order Entry</td>
<td>69-71</td>
</tr>
<tr>
<td>3.9.1-</td>
<td>Buy Smart Order Entry</td>
<td></td>
</tr>
<tr>
<td>3.9.1 Sell Smart Order Entry</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---</td>
<td></td>
</tr>
<tr>
<td>3.10- Spread Order</td>
<td>71</td>
<td></td>
</tr>
<tr>
<td>3.11- Exercise/Delivery</td>
<td>72</td>
<td></td>
</tr>
<tr>
<td>3.12- Order Book</td>
<td>72-73</td>
<td></td>
</tr>
<tr>
<td>3.13- Order Query</td>
<td>73</td>
<td></td>
</tr>
<tr>
<td>3.14- Trade Book</td>
<td>74-77</td>
<td></td>
</tr>
<tr>
<td>3.15- Trade Query</td>
<td>77</td>
<td></td>
</tr>
<tr>
<td>3.16- Net positions</td>
<td>77-78</td>
<td></td>
</tr>
<tr>
<td>3.17- Admin Order Tray</td>
<td>78-80</td>
<td></td>
</tr>
<tr>
<td>3.18- Order History</td>
<td>80-81</td>
<td></td>
</tr>
<tr>
<td>3.18- Bulk Trades</td>
<td>81</td>
<td></td>
</tr>
<tr>
<td>3.19- Exercise/Delivery Book</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>3.20- Spread Order Report</td>
<td>82</td>
<td></td>
</tr>
<tr>
<td>3.21- Partial Position Conversion Query</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>3.22- Modified Trades</td>
<td>83</td>
<td></td>
</tr>
<tr>
<td>3.23- Order Slicing</td>
<td>83-86</td>
<td></td>
</tr>
<tr>
<td>3.23.1 Order Slicing Window</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.23.2 Order Slice Book</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3.23.3 Immediate Order Slice Dialog</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| 4- Web Links                  | 87 |
| 5- Grouped orders             | 87 |

<p>| 6- Preferences                | 88-98|
| 6.1- Hot Keys                 | 88 |
| 6.2- Tool Bar                 | 88 |
| 6.3- Message Bar              | 89-90|
| 6.4- User Settings            | 90-97|
| 6.4- Status Bar | 97 |
| 6.5- Tool Bar Settings | 98 |
| 6.6- News Ticker Bar | 98 |
| 6- Surveillance | 99-114 |
| 6.1- RMS Limits | 99-100 |
| 6.1.1- View Limits | 100-101 |
| 6.1.2- Update Limits | 101-104 |
| 6.1.3- Rejected List | 104 |
| 6.1.4- Position Alert | 105 |
| 6.1.5- RMS Surveillance Screen | 106 |
| 6.2- Category | 107 |
| 6.3- T1 Holdings | 108 |
| 6.4- Scrip Margin | 109 |
| 6.5- RMS Ban Symbols | 109-110 |
| 6.6.1 FO Banned symbols | |
| 6.6.2 View FO Banned Symbols | |
| 6.7- Scrip Basket | 110 |
| 6.8- Scrip Group | 110 |
| 6.9- Restricted Scrip Basket | 111 |
| 6.10- NRI Scrip Basket | 111 |
| 6.11- RMS Blocking | 112 |
| 6.11.1 Block/unblock Orders | |
| 6.12- Auto Square Off Exclusion List | 113 |
| 6.13- Execute Auto Square Off | 114 |
| 6.14- Admin Square Off | 114 |
| 6.15- Place AM Orders | 115 |
| 6.16- Start storing AM Orders | 115 |</p>
<table>
<thead>
<tr>
<th>Section</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>6.17</strong></td>
<td>Stop storing AM Orders</td>
</tr>
<tr>
<td><strong>7</strong></td>
<td>Masters</td>
</tr>
<tr>
<td><strong>7.1</strong></td>
<td>Entity Management</td>
</tr>
<tr>
<td><strong>7.2</strong></td>
<td>Refresh Entity Hierarchy</td>
</tr>
<tr>
<td><strong>7.3</strong></td>
<td>Admin Position</td>
</tr>
<tr>
<td><strong>7.4</strong></td>
<td>Client Wise Position</td>
</tr>
<tr>
<td><strong>7.5</strong></td>
<td>Report Generator</td>
</tr>
<tr>
<td><strong>7.5.1</strong></td>
<td>Format Editor</td>
</tr>
<tr>
<td><strong>7.5.2</strong></td>
<td>View Report</td>
</tr>
<tr>
<td><strong>7.5.3</strong></td>
<td>Generate Dealer Report</td>
</tr>
<tr>
<td><strong>7.5.4</strong></td>
<td>Generate Client Report</td>
</tr>
<tr>
<td><strong>7.5.5</strong></td>
<td>Generate Investor Client Report</td>
</tr>
<tr>
<td><strong>7.6</strong></td>
<td>Role Manager</td>
</tr>
<tr>
<td><strong>7.7</strong></td>
<td>Display Logged In users</td>
</tr>
<tr>
<td><strong>7.8</strong></td>
<td>Display Subscriptions</td>
</tr>
<tr>
<td><strong>7.9</strong></td>
<td>Search/Activate Entity</td>
</tr>
<tr>
<td><strong>7.10</strong></td>
<td>Action Right</td>
</tr>
<tr>
<td><strong>8</strong></td>
<td>Tools</td>
</tr>
<tr>
<td><strong>8.1</strong></td>
<td>Option Calculator</td>
</tr>
<tr>
<td><strong>8.2</strong></td>
<td>Position Analysis</td>
</tr>
<tr>
<td><strong>8.2.1</strong></td>
<td>Implied Volatility</td>
</tr>
<tr>
<td><strong>8.2.2</strong></td>
<td>Implied Volatility Graph</td>
</tr>
<tr>
<td><strong>8.2.3</strong></td>
<td>Refresh Position</td>
</tr>
<tr>
<td><strong>8.2.4</strong></td>
<td>Delete Position</td>
</tr>
<tr>
<td><strong>8.2.5</strong></td>
<td>Scenario Analysis</td>
</tr>
<tr>
<td><strong>8.3</strong></td>
<td>Option Strategy</td>
</tr>
<tr>
<td><strong>8.4</strong></td>
<td>What If Analysis</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>8.5- Messaging</td>
<td>133</td>
</tr>
<tr>
<td>8.6- Set Alert</td>
<td>133</td>
</tr>
<tr>
<td>8.7- Set Order Alert</td>
<td>135</td>
</tr>
<tr>
<td>8.8- Order Alert List</td>
<td>135</td>
</tr>
<tr>
<td>8.9- Lot Converter</td>
<td>136</td>
</tr>
<tr>
<td>8.10- Offline Portfolio</td>
<td>137</td>
</tr>
<tr>
<td>8.10- Dollar to Rupee Converter</td>
<td>137-138</td>
</tr>
<tr>
<td></td>
<td>138</td>
</tr>
</tbody>
</table>
Retail Features in NT

Menus and options under them in NT for retailers and their use:

**File Menu**

The File menu is there for log related features. The options available inside this menu are:

1) **Login:**
   User can login through this option if he closed the login window but if he already logged in, the option will be disable for him. The short cut assigned for it is F9.

<table>
<thead>
<tr>
<th>File</th>
<th>Market</th>
<th>Orders and Trades</th>
<th>Web</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>F9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logout</td>
<td>F10</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Lock App</td>
<td>Ctrl+W</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh Broadcast</td>
<td>Ctrl+F5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Refresh Clients</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Get Log Messages</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change Password</td>
<td>Ctrl+Shift+F9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Delete Scrip Files</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Log Info</td>
<td>F7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Admin Log</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2) **Logout:**
   If user wants to logout from NT either he can use this option or press F10 or can choose the option Exit or can direct close the window. Once he attempts to close the application the confirmation pop-up will appear. If he wants to Exit with saving all his market setting, he can select “yes” else “no”. In case he doesn’t want to Exit can select “cancel”.
3) **Lock Application** *(Ctrl+W)*:
This option is used to secure the application from unauthentic use. Once you lock the application the orders can not be placed or any other dialog/information can not be retrieved until and unless the application is unlocked by entering the password of exe.

4) **Refresh Broadcast** *(Ctrl+F5)*:
Use to refresh broadcast from channel. If selected returns a confirmation prompt; after which it disconnect and reconnect from the channel to get the broadcast again.

5) **Refresh Clients**:  
Uses to refresh the entity hierarchy in NT.
6) Get Log Messages:
Use to get the log messages in Log window, if selected first prompt will ask if you want to get log messages and if selected “Yes” next prompt will appear if you want to get Exchange messages.

7) Change Password (Ctrl+Shift+F9):
Option uses to change the NT login Password. If selected following dialog will be displayed where you have to enter Old password and New one with which you want to replace that, and in “Confirm Password” field you have to re-enter the new password to apply the changes. If successfully changed, it will return a confirmation prompt.
8) Delete Scrip File:
Uses to delete the scrip file present in Nest Folder. If selected returns a confirmation prompt stating the number of scrip file has been deleted.

9) Log Info (F7):
Use to get all log messages in NT. The option leads you to the window where you can get all log related information.
10) Exit:
Use to exit from exe. If selected returns a prompt asking if you really want to exit, if click on yes, the exe will get closed.

Market

1) Market Watch profile:
Short cut key F4 has been assigned to it. Once clicked the market watch window will open.

Reposition Column: User can rearrange the market watch columns from “Repositions Column” option available on doing right click on market watch profile header (where you can see all the labels like exchange, symbol, best buy rate, etc.). From this dialog, you can select the columns you want to keep in market watch and click on save button.
- **Buy Order Entry:**
  Short cut assigned F1 or can be invoked through “+” key and uses to place Buy Order for selected Scrip. Once clicked following window will appear where user can fill the quantity, price and client Id for whom he is going to place the order.

- **Sell Order Entry:**
  Once clicked on this option following window will appear which uses to sell the selected scrip. The short cut key F2 (or can be invoked by “-“ key) assigned to it. User has to fill all required fields before click on submit button.
- **Order Book:**
The placed order will get traded if they find the counter Open Order immediately else will go open and user can find them in Order Book. The Order Book is divided into two frames; Open orders & completed Orders; The Orders which has not found the match yet will be there in Open Orders Frame where as the traded orders can be seen in Completed Orders Frame. User can also see all cancel or rejected trade along with the reason in Completed Orders Frame. The Short cut to invoke Order book is **F3**.

Following options are there under right click

II. **Order History:** Will show the history of selected placed order along with the time. Short cut **Shift+F12**

III. **Set order Alert:** The Order alert can be set, it will return a pop-up as soon the alert get triggered.
IV. Set Security Alert: It will return a pop-up if the security with the given alert price has been triggered.

V. Grid Lines: Will draw the grid lines inside the window between rows and columns. Short cut Shift+G

VI. Write To Excel: This option will allow user to write all his Orders to Excel file. Short cut assigned to this option is Shift+E

VII. Copy To Clip Board: It will copy the items to clip board, user can paste wherever he wants. User can also use this option by using Shift+C as short cut.

VIII. Open Orders: Once Selected will show the open orders. Short cut Alt+1 is assigned to this option.

IX. Open Pending Orders: if this option is selected will show only open pending orders. Alt+2 is the short cut to invoke the orders.

X. Validation Pending Orders: This option will return only the open orders which are not yet validated. Alt+3 can be used as short cut.

XI. Frozen Orders: If Frozen orders option selected only Freeze orders will show in the window. Alt+4 can be used to invoke all Frozen orders.
XII. Acknowledged Orders: Once the option selected only acknowledged Orders will be displayed (the orders which have placed but only have the status as “put order request received”).

XIII. After Market Orders- Fresh: It will return the open After Market orders placed but which are not modified.

XIV. After Market orders- Modified: It will return only Modified After Market Orders.

XV. All orders: If this option is selected, it will show all open orders without any condition.

XVI. Link Orders: User can link the selected order to the Basket. Once selected following window will appear; where he has to fill the basket, wave and line Id. Once he fills all these fields the order will linked to the assigned basket.

XVII. Customize: User can change the appearance of dialog with the help of this option.

○ Trade Book:
All placed orders which have been traded can be seen in this dialog. Short cut to invoke trade book is F8.

Option available in trade book:

a- The check box (Display All Trades); if this is checked all trades can be seen in the dialog else trades for selected scrip will show.
b- Show filter: This option is available here to filter the trades; once clicked the filter row will appear just below the header row, where values can be given for any row any the trades will be filtered accordingly. Can be invoked by short cut key **Ctrl+F**.

c- Filter Trade: This option is there in trade book to filter the trade according to their type. Once clicked following window will appear:

![Trade Filter Window]

So trades can be filtered according to the set criteria.

d- Display: Once clicked on this option all trades will show, which means if trades have been filtered user can get all trades back by clicking on “Display” button.

e- Position Conversion: Position conversion is there to change the product type. Once clicked following window will display;
User has to select the new product type he wants to change and click on “Convert” button.

f- Bust: In NT this option is there if user wants to modify the trades which belong to NSE exchange. If user clicks on this option a new dialog will open on his screen.

This option can be used when user wanted to trade in some account but he did that for another client by mistake. User has to enter the account Id for which he wanted to trade.
g- Modify: In case the trades which don’t belong to NSE can be modified though this option. A similar window will appear in which user can give the desired account Id.

- **Create Basket-Buy:**
  It allows user to create a Basket for buy. When user clicks on it following dialog will appear on his screen;

![Create Basket - SHWETA-OTPUAT window](image)

Here user can fill all the values to create a buy basket, in case he wants to enter more than one line he has to click on the check box “Multiline”, if he chooses this option the dialog will change

![Create Basket - SHWETA-OTPUAT window](image)

To add each line user has to fill all the required field and click on “Add Wave” button to add it in the Basket. Once it is done user should click on “Create
basket” to place the buy basket orders. Once this button is clicked following window will appear on his screen, which ask user’s permission for each line and if he accept all lines it will go as open lines in OI Monitor. User can save this by clicking on “Generate” button.

- **Create Basket-Sell:**
  The option is same as “Create Basket-Buy”. The only difference is it is used to sell the created basket.

- **Actions:**
  All action related to market watch can be seen here; following options are there it;
  
  a- Insert Blank Line: If user wants to insert a blank line between two rows in market watch he can select this option or can press the “Insert” Button from his key board as short cut.

  b- Load Default Market Watch: This option can be used if user wants to load a default market watch instead of his current market watch. Short cut for the option is Ctrl+N
c- Set as Default Market Watch: In case user wants to set the current market watch as default, he has to select this option. Once clicked user will get a message in message bar saying the market watch has been saved along with the scrip order. Short cut assigned to it is Ctrl+M.

d- Move Outside: The market watch window will go for full screen if user selects this option or short cut key Alt+F3.

e- Move All Groups Outside: In case user wants to open all market watches as full screen, he can opt this option.

  o  Act On call
     * Place Normal Order:
     * Place SL-M Order
     * Place Cover Order
     * Place Bracket Order

  o  Tools:

a- Scrip properties: If clicked on this option the scrip property dialog will open for the selected scrip, where user will be able to see all scrip related details.
If user wants to add more or all the fields available in NT he can click on the “Configure” button, and selects the options he wants to get the values for and then press “Apply” button. The fields will be added to the scrip property dialog.
b- Option Calculator: Option calculator can be used to check the selected option contract value at that time. Once it clicked there following dialog will come on your screen. User has to give all related information viz. expiry date, option type, strike price, input values, volatility and interest rate etc. to get the Option Greeks values.
c- Implied Volatility: Once this option has been selected a small window will appear in which Implied Volatility can be seen for the Future and Cash for selected scrip in Position Analysis window. Implied Volatility window can also be invoked using shortcut Key F5. The prices can be refreshed by clicking on refresh button.

d- Implied Volatility Graph: The second option available on right click is an Implied Volatility Graph. This option provides a real time graph for the selected contract. By default it will show the graph
for call as well as put option that keeps on changing on real time basis.

User is also provided with various options such as type of options, strike price range, expiry date, type of underlying, etc., to customize the implied volatility graph for particular scrip. The shortcut key to invoke Implied Volatility Graph is **Shift+F5**

e- Derivatives Chain: Once selected following dialog will return the equity and the future contracts available on the scrip. If user selects the check box available in the left upper corner, it will return all option contracts too, which are available for that selected scrip along with the strike price. User can also save it as a group for which he has to give a name to the group. Once it is done this group will be there as a new market watch group.
f- Add Ticker Scrips: This option is there to add the ticker scrip in ticker bar. Once selected following window will appear;

<table>
<thead>
<tr>
<th>Symbol</th>
<th>LTP</th>
<th>Ask Qty</th>
<th>Ask R</th>
<th>% C</th>
<th>Open</th>
<th>Bid Qty</th>
<th>LTT</th>
<th>Total</th>
<th>Strike</th>
</tr>
</thead>
<tbody>
<tr>
<td>INFY</td>
<td>2734.35</td>
<td>2</td>
<td>2734.30</td>
<td>0.77</td>
<td>0</td>
<td>50</td>
<td>19/07/2011</td>
<td>12:51:19</td>
<td>8398790</td>
</tr>
<tr>
<td>INFY</td>
<td>2743.65</td>
<td>1.25</td>
<td>2743.50</td>
<td>-0.75</td>
<td>3739975</td>
<td>125</td>
<td>19/07/2011</td>
<td>12:51:17</td>
<td>0</td>
</tr>
<tr>
<td>INFY</td>
<td>2755.60</td>
<td>250</td>
<td>2755.50</td>
<td>-0.74</td>
<td>322825</td>
<td>375</td>
<td>19/07/2011</td>
<td>12:51:16</td>
<td>0</td>
</tr>
<tr>
<td>INFY</td>
<td>2770.10</td>
<td>1000</td>
<td>2770.35</td>
<td>-0.58</td>
<td>8675</td>
<td>125</td>
<td>19/07/2011</td>
<td>11:16:03</td>
<td>0</td>
</tr>
</tbody>
</table>
User has to select the exchange and scrip he wants to add in the ticker. Once he added all desired scrip and click on “ok” button, the scrip will be added to the ticker bar. Now if any changes occur in prices it will reflect in the ticker bar.

g- Compare Scrips: The Compare scrip feature is for comparing scrip based on the different market data columns available. You can formulate the strategy using the scrip present in market watch, the market parameters and the arithmetic & logical operators. Once you formulate the strategy the live values for the same can be observed in Scrip comparison bar
h- Put Call Parity: Put call parity can be invoke only for Option Scrip’s. \( C + X = F + P \) where \( C \) call option last traded price, \( X \) is Future strike price, \( F \) is the future Last Traded price, \( P \) is put option last traded price. This is the equation to calculate the put call parity equation that will be added to scrip comp dialog bar.

i- Combined Market depth: This option will return the top 10 bid and ask along with price.

![Combined Market Depth of - LT](image1.png)

j- Combined VWap: Here user can get the VWap for given qty or vice-versa.

![Combined VWap - ALBK-EQ - SHW...](image2.png)

k- News: If news indicator is there for scrip and if user selects this option, the news related to that scrip will show in a new window. Until n unless the news indicator is there the news window will not open. Short cut Shift+N assigned for it. Market Watch
Indicator N (in red) indicates fresh news available for the scrip, N (in green) indicates news available was read by user.

Once the option is selected all news related with the scrip will come in the news window and user can click on indicator to get the full story over that.
User Defined Column:

User can add any number of columns in market watch window and delete those with the help of this option. Two options have been provided under this; 1- add; 2- delete

1- Add: If the option is selected a dialog will appear in which user can define his customized column along with a column name.
2- Delete: The added column can be deleted with this option. The dialog is as same as “Add” only difference is in place of button “Add” it is “Delete” one.

   ○ **Dialog Bars:**
   Options under this are for invoking the different dialog bar which may be useful for user
   a- Show Scrip Dialog Bar: It will return the scrip bar where the scrips can be added to the market watch, the short cut Ctrl+S is assigned to invoke the dialog. User has to press enter if he wants the selected scrip in his market watch.
b- Show Index Value Bar (Ctrl+I): This option will return the Index dialog bar, where the user will be able to see indices moving. Once he opts for the option a blank dialog will appear;

To get the index and values user has to right click on this dialog. Following options are there in right click;
- Show indices dialog: It is a window containing all indices in it. User can right click and select the option “Add to dlgbar”. Few more options are available in right click on the dialog. These are;

```
a. Add to Dlgbar: To add selected index to index dialog bar.
b. Delete from Dlgbar: To delete selected index from dialog bar
c. Set Index Alert: To set index alert.
d. Draw Index Intraday Chart: To invoke Intraday Chart for selected Index
e. Write To Excel: To write the indices with the values to Excel
f. Draw Gridlines: To draw gridlines inside the dialog
```
- Column Headers: The column header will appear if this option is selected.

```
<table>
<thead>
<tr>
<th>Index Name</th>
<th>Index Value(Diff With Close)</th>
<th>Indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>S&amp;P CNX Nifty</td>
<td>5590.50(23.45)</td>
<td></td>
</tr>
<tr>
<td>India VIX</td>
<td>19.25(-0.95)</td>
<td></td>
</tr>
</tbody>
</table>
```

- VWap Statistics: All data in given interval along with Open, Close, High, Low, Start and End time will appear for selected Index.

```
<table>
<thead>
<tr>
<th>VWap Value</th>
<th>Open Rate</th>
<th>Close Rate</th>
<th>High Rate</th>
<th>Low Rate</th>
<th>Start Time</th>
<th>End Time</th>
<th>Record No</th>
<th>Differential Vol</th>
<th>Cumulative</th>
</tr>
</thead>
<tbody>
<tr>
<td>5592.65</td>
<td>5592.60</td>
<td>5592.65</td>
<td>5593.60</td>
<td>5562.25</td>
<td>04:15:00 PM</td>
<td>04:15:00 PM</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5592.60</td>
<td>5579.75</td>
<td>5582.25</td>
<td>5590.50</td>
<td>5577.25</td>
<td>04:05:00 PM</td>
<td>04:05:00 PM</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5579.65</td>
<td>5579.30</td>
<td>5579.00</td>
<td>5560.00</td>
<td>5579.20</td>
<td>04:00:00 PM</td>
<td>04:00:00 PM</td>
<td>3</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5579.25</td>
<td>5572.85</td>
<td>5572.50</td>
<td>5560.50</td>
<td>5571.60</td>
<td>04:00:00 PM</td>
<td>04:00:00 PM</td>
<td>4</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5571.00</td>
<td>5597.95</td>
<td>5573.00</td>
<td>5599.00</td>
<td>5571.45</td>
<td>03:59:00 PM</td>
<td>03:59:00 PM</td>
<td>5</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5596.35</td>
<td>5587.55</td>
<td>5586.00</td>
<td>5580.00</td>
<td>5584.20</td>
<td>03:45:00 PM</td>
<td>03:45:00 PM</td>
<td>6</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5596.40</td>
<td>5577.95</td>
<td>5586.40</td>
<td>5597.90</td>
<td>5577.25</td>
<td>03:40:00 PM</td>
<td>03:40:00 PM</td>
<td>7</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5570.00</td>
<td>5503.00</td>
<td>5570.05</td>
<td>5613.55</td>
<td>5577.35</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>8</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5613.55</td>
<td>5579.10</td>
<td>5613.55</td>
<td>5613.55</td>
<td>5577.95</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>9</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5613.65</td>
<td>5613.55</td>
<td>5613.55</td>
<td>5613.55</td>
<td>5613.55</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>10</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5613.55</td>
<td>5613.55</td>
<td>5613.55</td>
<td>5613.55</td>
<td>5613.55</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>11</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5606.75</td>
<td>5606.75</td>
<td>5606.75</td>
<td>5606.75</td>
<td>5605.65</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>12</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5606.00</td>
<td>5610.15</td>
<td>5610.00</td>
<td>5610.55</td>
<td>5605.00</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>13</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5610.45</td>
<td>5613.35</td>
<td>5610.45</td>
<td>5613.50</td>
<td>5609.40</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>14</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5613.05</td>
<td>5613.25</td>
<td>5613.55</td>
<td>5620.50</td>
<td>5613.95</td>
<td>03:30:00 PM</td>
<td>03:30:00 PM</td>
<td>15</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
```

- Remove Index: Use to remove selected index from Index dialog Bar.
- Draw Intraday Index Chart: Draw the Intraday chart for selected Index.
o  Fit to Data:
  o  Fit to Window
  o  Draw Grid Lines

Short cut Ctrl+I is assigned to invoke the Index Dialog Bar.

c- Show Ticker Bar: This option can be selected if user wants to see the scrip ticker bar on the screen. User can invoke the ticker bar using Ctrl+K as short cut.

d- Show OI Control Bar: Will show the open and completed lines of the placed basket. It’s a dock-able window so can be placed any side of the application. Short cut Ctrl+O is assigned to invoke this dialog bar.
e- Show Scrip Comparison Bar: The scrips which have been compared using Tools → Compare scrips will show here along with the value.
f- Show News Bar: This option is there to invoke the News Bar. Once selected following bar will display on the screen. Alt+F4 can be used as short cut to invoke News Bar

g- Show Heat Map: This dialog will show if the scrips of the market watch moving positive or negative direction and either in ascending or descending order along with the percentage change. Once the pointer placed on any of the scrip in heat map dialog it
will show the current values for that. Short cut is Ctrl+F to invoke Heat map dialog.

- **Cover Order:**
  User will be able to place Buy/Sell cover order with the help of this option. Short cut key for Buy cover order is Shift+F1 and for sell Shift+F2.

- **Bracket Order:**
  If user wants to place Bracket Orders he can use this option to buy/sell the bracket orders. Short cut assigned for buy bracket order is Shift+F3 and for sell bracket order is Shift+F4.

- **Security Alert:**
  The security alert can be set using this option. An alert is an action that is triggered when an event notification rule has been met. The alert action could be a notification like an e-mail, sms or pop-up. Alerts can be set at index level or other levels.

  A user can set the alerts for the index touching a specified level. Whenever the security meets the condition specified in the alert it gets triggered.

  When entering an alert, following data are to be entered.
  
  - Scrip name along with the exchange it belongs
  - Alert condition (less than or equal to, Greater than or equal to, less than, greater than, )
  - Value; a scrip value which meets the alert condition
  - Validity for the day
  - Mode of informing the person about the alert, whenever it gets triggered; through E-mail, sms or TWS
  - Remarks
Once the alert has been set, confirmation will be given with the alert id.

- **Intraday Chart:**
  Option can be used to invoke Intraday Chart for selected scrip. Short cut `Shift+C` is assigned for to invoke it.
- Historical Chart:
The Historical Chart can be invoked using this option; charts are available for 3 months, 6 months and a year. User can also enter the dates between which he wants to see the movements in the scrip.

- The Windows Horizontally:
The windows will be tiled horizontally if user selects this option.

- The Windows Vertically:
All the windows go tiled vertically if this option is opted.

- Gridlines:
This option will draw the gridlines (rows and columns) in the market watch window.

- Write To Excel:
The whole market watch can be written in the Excel using this option.
- **Link To Excel:**
  In case user wants the NT linked to Excel for better view, he can choose this option. All he has to do is first select this option then open the excel file and paste it there. All scrip along with all the values will come there in excel, and it will be interactive with NT.

- **Customized:**
  User can change the background and foreground color and text settings using this option.

- **Refresh Market watch scrip:**
  This option can be used to refresh market watch manually.

- **Subscribe For this Group:**
  If user wants to subscribe all the scrip for selected market watch group, he can use this option, and all the items (scrips) will be checked on.

- **Subscribe On Check:**
  If user wants to subscribe or unsubscribe some of the scrips in selected market watch, he has to select this option first. Once he selected this option the check box will appear before all scrips, he can selects or deselect the scrip he wants to subscribe for.

- **Add My Holdings:**
  This option will allow you to add the select scrip to your holdings.

2) **Market Watch Group Settings:**
   The option allows you to change the market watch group settings. Window can be invoked through short cut Ctrl+G.
Here new group can be created or updated the existing one. Following tabs are available in Group settings window:

a- Group Name: To add new group in market watch.

b- Options: Here you can add securities in bulk according to your chosen option. Following options are there;
   I. All future securities for selected expiry
   II. All option securities for selected expiry
   III. All option securities for selection
   IV. All securities for selected market type
   V. All underlying scrips for futures.

c- Security: you can add scrips in your selected market watch with the help of this.

d- Import Group: The groups which have been created earlier can be imported in future if needed.

e- Export Group: The groups which have been created can be exported to particular location in the system for future reference.
Options available in right click in the group name:

- **Group Settings Options**
  a- Rename this Group: The selected group name can be changed (renamed).
  b- View this group: To view the underlying of the selected group.
  c- Export this group: To export the selected group.
  d- Import this group: To import selected group.

- **Bulk Addition of Securities in the Group**
  e- Add all futures securities for the selected expiry
  f- Add all options securities for the selected expiry
  g- Add all underlying securities for the futures
  h- Add all securities for the selected market type

- **Bulk Deletion of Securities in the Group**
  i- Delete all options securities for the selection
  j- Delete all option securities for the selected expiry
  k- Delete all futures securities for selected expiry
  l- Delete all securities for selected market type
3) **Load Pre-defined Market Watch:**
This option will load the pre-defined market watch in Nest trader.

4) **Conditional Market Watch:**
It will generate a new market watch with the given condition. Once selected following dialog will appear, where user has to select a group for which he is creating a conditional group along with an expression on which basis it generates the group, it will show the securities in new market watch if the given condition is true.

![Conditional Market Watch](Conditional_market_watch.png)

5) **Snap Quote:**
The market depth/snap quote dialog shows the best-five information and other trade statistics. User can invoke Order Entry, Order book and Trade Book. User can either invoke through F6 or through menu option Market-Snap Quote.
6) **Top N:**

The top 10 Gainers and Losers will be displayed according to given value. User can choose any of the three available options in it.

1. Trade Volume
2. Trade Value
3. % Change previous close

Short cut `Ctrl+shift+T` is assigned to invoke the dialog.
7) **VWap Statistics:**
   It will return the VWap for selected scrip. The time interval should be given between 5 and 60 minutes. The short cut key is Ctrl+Shift+H for it.

![VWap Statistics](image)

8) **Combined Market Depth:**
   Same as the one which is there in the right click option in market watch. Short cut is Ctrl+Alt+F6.

9) **Security List:**
   A dialog which will allow user to add scrips and will show the related information (which are also there in scrip property window). Short cut Ctrl+F7 is assigned to invoke the window.
10) News:

The option will lead user to the news window where he will be able to see News, Trading Calls or Research, which are there if user right clicks in the window.

a- Add Tab:
User can add new news tab which will show the news he selected for. News items can be selected from the Add news tab.
b- Delete:
Option can be used to delete the added news tab. Once clicked will return a prompt for confirmation before delete the tab, but here the “News Manager” group can not be deleted.

c- Hide Story:
If selected the news will show only headlines, by default it shows little more than a headline.
11) Nest Notification:
Similar to message bar which shows all notification from Nest. Short cut Ctrl+Alt+N

12) Search & Add Contracts:
The scrip can be searched and added in the market watch through this option. Short cut Ctrl+Shift+S is assigned to it. If right clicked on a selected contract, it can be added to the market watch or to the store.
13) **Price Ladder (Ctrl+Alt+P):**

In Price Ladder you can see the LTP highlighted by light blue color along with the LTQ, also shows the best 5 bid and ask quantities along with the respective prices. Bid quantities will be **Blue** in color whereas ask will be in **Red**.

The price Ladder will show the best 5 Bid and Ask vertically which is same as the Snap Quote, both window shows the market depth.
When you invoke the Price Ladder, a window (Price Ladder Order Entry) will open along with it. In Price Ladder Order Entry, you have been given three options to place your order, you can choose any of them; these are:

I. **Manual**: Manual option is allow you to place the order for that scrip with your desired quantity and price, once it gets counter order, it will get triggered. Here you can place the order for **BUY/SELL or BOTH**.

II. **Opposite**: Next option available on this window is “**Opposite**”, if chosen will return you the best **ask price** available for **Buy order** and best **Bid price** available for the **Sell Order**, which can be used short positions (Intraday)

III. **VWAP**: If you are selecting VWAP, you will be given two options in that

   a. **Get VWAP**: Get VWAP option will allow you to get the best price available against your quantity, in this case you can enter your desired quantity and the price will get set automatically. It will also show approximate VWAP for your order.

   b. **Get quantity**: Get Quantity option will offer you the best quantity against your price. You have to fill your price and it will return you the quantity available for that price.
14) Market Monitor:
Market Monitor Window alerts you whenever Stock touches new level. Short cut key is Ctrl+Shift+I.
There are six kind of alert provided by the Market Monitor window. These are as follows

- 52 Week High or Yearly High
- 52 Week Low or Yearly Low
- Days High
- Days Low
- Nearing Lower Circuit Limit
- Nearing Upper Circuit Limit

All these alerts are calculated based on the last trading price (LTP) of the Stock. Once the value is true it gets triggered. User can change the setting for each and every alert type. All Trading option can be invoked even if the user is on Market monitor window either by right click in the Market Monitor or by pressing the short cut key after selecting a Triggered Message viz. F1, F2, F3, F8 etc.

Orders and Trades:
Under this menu all option are available which are required for either orders or trades. The options available and their descriptions are as follows:

1) Basket Orders:
Baskets are their in NT for bulk trading. Following types of baskets are available here;
   a- Normal basket:
The Normal Basket is used for adding different scrips for different client. They can add no of client with different or/and same scrips. It can be invoked either through menu or through shortcut key Ctrl+B. Once selected following window will appear
In this window you have to fill the minimum fields to add the waves into the basket. To add the waves you have to click on “Add” button, and after finishing the adding to release the waves into the market you have to click on “Place” button.
The created basket can be saved as excel format by clicking on “Export list” button where as at some point of time can be invoked by clicking on “Brows” button and selecting the desired file.

If you want to slice the wave (breaking the whole order into bunch of orders with different quantity) you have to click on “Slice” button, once you click on it following window will be shown on your screen

To slice the waves you have to give start and End Time along with interval at which you want to slice the waves and click on “Place” after clicking on “Slice” button. The Order Slice Book will open where you can see the trigger pending/complete along with slice details. Trigger pending slices can be placed manually by selecting and click on “Place slice(s)”. But only one slice can be placed at a time.
b- Balanced Basket:

Once you click on Balanced Basket, it will ask you the name of the basket. After entering the name, the Balanced Basket window will appear on your screen.

In which you have to enter the value for which you are going to buy/sell the basket. If the balanced basket is for buy, the dialog will be blue in color and the constituent you get for sell, still it can be reversed through the option provided “Reverse” in the dialog itself. This basket can be saved in a particular location using “Create” tab, and sliced through “Slice”.
c- Direct Basket:
Direct basket will also ask you the name before proceeding forward. Giving a name to the basket will take you to the direct basket dialog; where on the basis of given value and indices chosen for basket you will get the constituents. Unlike balanced basket if you are willing to go for buy it will return the buy values and for sell returns the sell basket, But if you want you may change the constituent of buy basket into sell by clicking on tab “Reverse”. The basket can be saved by using “create”; lines can be placed by “place” tab, whereas slicing through “slice”. The weight form one scrip to another can transfer by using transfer weight option which is available in the dialog.
d- Spread Basket:
Spread basket is used for placing the basket order for derivatives. The basket can be saved and a saved basket can be invoked by using “Export list” and “Brows” tabs respectively. Once the desired lines have been added it can be placed through “place” tab. The lines in the basket can be modified if double clicks on a selected one and the “Add” tab will change into “Modify”.

www.omnesysindia.com
e- Add/Delete/Edit customized Basket:
This option allows you to create your own baskets based your preferences and needs of portfolio. You have to add scrips in it after giving it a name and the total weightage can not be more than 100, if you try to do so it will return a prompt message.
f- Customized Basket Order Entry:
The saved customized basket can be invoked here and get the constituent and place it if you want.
2) **Model Basket:**

Model portfolio is used for the dealer on the client instruction will be able to invest in the particular model portfolio from the NEST Trader. Following options are there in Model Basket.

- **Add/Delete/Edit Model Basket:**
  Dealer can give any name in Model Name combo. After entering all the exchange details and clicking on “ADD” button the particular scrip will get added in the Model Basket List. Additionally, in the status bar, the number of scrips and the weightage will get updated accordingly. To delete a scrip from the Model Basket list select that scrip and click on DELETE button. The selected scrip will get deleted from the list. Additionally, in status bar, the number of scrips and the weightage will get updated accordingly. Delete Basket will delete the portfolio along with the scrips present in that portfolio.

Save Basket option button will save the entered portfolio along with all the scrips in that portfolio. After re-login in Nest Trader, dealer can use the same portfolio for placing orders. Refresh button will refresh the entire Model Basket dialog.
- **Model Basket order Entry:**
  From the Model Name, select the name, enter the value and all the details (Price Type, Order Type, PRO/CLI, Prod Type, Validity, and Client Id, Client Name) to place the portfolio. On clicking "Get Constituents", the constituents of the model are retrieved and displayed in the list with the quantity and price as per the weightage of the model scrips. On clicking ‘Place’ button, all the orders will get placed. After placing the orders, the user will be able to see it in the Order (F3)/Trade Book (F8) and in the Log.

![Model Basket order Entry](image)

3) **After Market Orders:**
   - **Buy order Entry (Ctrl+F1):**
     Dialog can be used to place After Market buy Order.

![After Market Orders - Buy order Entry](image)

   - **Sell Order Entry (Ctrl+F2):**
     Use to place After Market Sell Orders.
Basket order (Alt+Shift+O):
Use to place After Market Basket Orders.

4) Buy Order Entry:
Short cut assigned F1 or can be invoked through “+” key and uses to place Buy Order for selected Scrip. Once clicked following window will appear where user can fill the quantity, price and client Id for whom he is going to place the order.
5) Sell Order Entry:
Once clicked on this option following window will appear which uses to sell the selected scrip. The short cut key F2 (or can be invoked by “-” key) assigned to it. User has to fill all required fields before click on submit button.

6) Cover Order entry:
Cover Order offers an order placement feature through which you can take intra-day position in the equity segment and at the same time, system place’s a cover order for this position specifying the Stop Loss Trigger Price and the limit price. This cover order will help you to limit the loss, if any, on the position. If selected, following option can be seen under it.

- Buy Cover Order Entry:
  Short cut Shift+F1 is assigned to it and use to place a buy cover order.
- **Sell Cover Order Entry:**
  
  `Shift+F2` is assigned as short cut to invoke sell cover order entry dialog.

When we are placing the stop loss order, trigger price should be within the range that is displayed in trigger price range box. Once the cover orders placed it can be seen in Order book and in log window. User can modify it there (in order book) or exit if he wants so.
7) Bracket Order Entry:
Bracket Orders can be used to hedge a position through square off with booking the profit or stop the loss at certain level (which will be according to your loss bearing ability).

- **Buy Bracket Order Entry:**
The dialog used to buy the bracket order. You have to place a buy order along with the profit booking square off price and a stop loss sell price. The dialog can be invoked through Shift+F3.

![Buy Bracket Order Entry](image)

Once the order gets placed can be seen in Order book and the traded on in Trade book.

- **Sell Bracket Order Entry:**
Use to place the Sell bracket order. Short cut is Shift+F4. Along with a sell order a buy square off order and a stop loss order will be placed according to the given values.

![Sell Bracket Order Entry](image)
Reflection Of Bracket Order in Order Book and Trade Book:
The placed Bracket order will go open once given all values and click “yes” in
confirmation dialog. The order gets triggered and will go to the Completed orders frame
in Order book. Where the placed price can be seen, For example if a Buy Bracket Order
is placed for ITC with 208 along with the square off at 5 ticks and stop loss at 207, in this
case the completed orders are buy ITC at 208 and as the given ticks were 5 so the selling
price would be 208.25 (5*0.05), since it reached up to the profit level the stop loss will
not be triggered.
8) **Trigger Order Entry:**

The Trigger Order allows you to place the order with the given condition. User has to set the condition on which basis it may get trigger. It can be used for risk minimizing tool for them as they can set their own condition to place the order.

- **Buy Trigger Order Entry:**
  
  Once the user selects the option, trigger order entry window will be shown on his/her screen. In this window user will be able to set the trigger condition for desired scrip. The shortcut key **Alt+B** is assigned to invoke the Trigger Order Entry.

- **Sell Trigger Order Entry:**
  
  If user wants to sell the scrip with the given condition, he/she has to invoke the Sell Trigger Order Entry window; he/she can invoke it either through menu (Orders and Trades → Sell Trigger Order Entry) or by pressing **Alt+S** as shortcut key. The following window will appear.
Trigger Conditions available in Trigger Order Entry

There are four types of conditions available on the Trigger Order Entry Screen:

- Last Trading Quantity (LTQ)
- Volume Traded Today
- Bid Qty
- Ask Qty
- LTP (Last Traded Price)
- Bid Rate
- Ask Rate
- Previous Close (Prev Close)

User can select any of them according to their need, for each condition there are five parameters:

a - Less than or equal
b - Greater than or equal
c - Less than
d - Greater than
e - Equal

Once it is placed the Admin role will start, he can accept or reject the placed trigger order through Admin Order tray option, which can be invoked by menu (Orders and Trades → Admin order tray). The Admin Order Tray window is divided into two frames, one is “Pre-validation List” and another one is “Validated list”.

In admin order tray also, initially when the order is placed, it goes to Put order state then once when the peer admin accepts it in his admin order tray the order will go open in this order (put order → open pending → open). The placed orders will go to the Admin-order-tray screen in Pre Validation List, where admin selects the orders and “Accept” or “Reject” it.
Now if admin has accepted the order it will go to the Order Book as an Open Order or else it will get rejected as the admin has rejected the order with the reason “rejected by GUI”.

The Open Orders will get triggered (Or complete) if the given conditions returns true value; which can be seen in either in Completed order frame in Order Book (F3) or in Trade Book (F8).

For Trigger Order it is necessary to peer with an admin or it will not go to the Admin Order tray, for that you have to go to Master menu → Entity Management → Entity Manager (Ctrl+Shift+E) and peer Admin. Once the peer has been done (e.g. Admin-Dealer), the admin will have the advantage to control the orders placed by the dealer.

9) Smart Order Entry:
The Smart Order in Nest Trader introduced to place the Order for the best price available for a scrip between two or more exchanges. It allows placing the Order in any of the exchanges (either NSE or BSE), so it tends to increase the profitability of portfolio.

- **Buy Smart Order Entry:**
  Once the user selects the option, Buy smart order entry window will be shown on the screen. User has to fill all the fields (according to their requirement) and press “Enter” key. The order will go as Smart Order.
the order will be placed to the exchange, where the price is lower as it is a buy order. The Order entry window also can be invoked by pressing the combination of keys Ctrl+Alt+A.

○ **Sell Smart Order Entry:**
If users want to sell the scrip with Smart Order, they have to invoke Sell Smart Order entry dialog; which can be invoked either through menu (Orders and Trades → Sell Smart Order Entry) or by pressing Ctrl+Alt+Q as shortcut key. The following window will appear;

Once the user places the Smart Order it goes to the exchange where the best price available for the scrip. Smart Order Entry; the quantity and price field has to be filled to place the order and since it does not have the field Exchange, which means it may place any of them where it finds the rate is best for buying the scrip.

SOR follows the mechanism:

- The Orders punched from the machine go to the SOR engine.
- Here the orders checks and compares the price available in both the exchanges.
- Send the order to the exchange where the best price is available for the placed Order.
- Order gets executed and the user will get the trade executed message in his message bar.
The Placed Order goes to the Order book as an open order with the exchange “ANY” (which can be seen in exchange column in order book), and once it gets triggered, goes to completed order frame along with the exchange name in Order book as well as Trade Book.

10) Spread Order:
Used to place the Spread Orders, Following three types of orders are available in it.

a. Spread Order: Only one order either Buy or sell can be placed in this option.

b. 2 L: This option is use to place 2L order.
c. 3 L: Option can be used to place 3L orders.

11) Exercise/Delivery:
To place the order for exercise or delivery. If selected following dialog will display where you have to fill all data and click on “send” to place the order.

12) Order Book:
Once you submitted the order from NEST Trader the order will be validated by the internal risk management system and then it will be sent to exchange and the confirmation will be placed on trader. Various order status messages that can be observed under order book are as follows:

- Put Order Request Received (After order acknowledged by server)
- Validation Pending (Order is going through risk validations)
- Open Pending (Order sent to Exchange)
- Open (Order confirmed by exchange)
- Modify Validation Pending (Order modification is going through risk validation)
- Modify Pending (Order Modification request sent to exchange)
- Modified (Order Modification confirmed by exchange)
- Not Modified (Order Modification rejected by exchange)
- Cancel Pending (Order Cancel request sent to exchange)
- Cancelled (Order Cancellation confirmed by exchange)
- Not Cancelled (Order Cancellation rejected by exchange)
- Rejected (Order Rejected by exchange)
- Order Frozen (Order frozen at exchange)
- Lapsed (Order lapsed at application server level due to exchange disconnection)

When you call the order book from market watch selecting scrip, the order book by default filters the orders for that scrip only. If you call F3 twice then the order book will display all the orders. If you want to view all order orders on single F3, you can check “Display orders without context” option present on the top of order book.

In NEST Trader you can filter in order book, trade book and net positions by calling CTRL+F. You can filter across the columns present in the dialog. If the order got rejected, the respective rejection reason will be displayed in the rejection reason column in the completed orders part in the order book.
13) **Order Query:**

The query about how many orders placed for an account or by a dealer, it will return all the placed (open as well as completed orders).

14) **Trade Book:**

All placed orders which have been traded can be seen in this dialog. Short cut to invoke trade book is F8.
Option available in trade book:

a. The check box (Display All Trades); if this is checked all trades can be seen in the dialog else trades for selected scrip will show.

b. Show filter: This option is available here to filter the trades; once clicked the filter row will appear just below the header row, where values can be given for any row any the trades will be filtered accordingly. Can be invoked by short cut key Ctrl+F.

c. Filter Trade: This option is there in trade book to filter the trade according to their type. Once clicked following window will appear

![Trade Filter Window](image)

So trades can be filtered according to the set criteria.

d. Display: Once clicked on this option all trades will show, which means if trades have been filtered user can get all trades back by clicking on “Display” button.

e. Position Conversion: Position conversion is there to change the product type. Once clicked following window will display;
User has to select the new product type he wants to change and click on “Convert” button.

f. Bust: In NT this option is there if user wants to modify the trades which belong to NSE-Cash market. If user clicks on this option a new dialog will open on his screen.

This option can be used when user wanted to trade in some account but he did that for another client by mistake. User has to enter the account Id for which he wanted to trade.
g. Modify: In case the trades which don’t belong to NSE-Cash can be modified though this option. A similar window will appear in which user can give the desired account Id.

15) **Trade Query:**
Same as Order Query dialog only difference is it returns only traded orders.

16) **Net positions (Alt+F6):**
Dealer Net Positions will be able to view the orders placed only by that particular dealer. You can view the positions in Net Position dialog (ALT+F6). You can filter the positions by using Ctrl+F and then selecting the filter level.
By default the net position displays Day-wise positions. By selecting the Net-wise option, you can view the carry forward positions and day-wise positions.

In net position dialog, you can view the live MTM value for every position and also the net MTM will be shown at the bottom of the dialog

17) **Admin Order Tray:**

Admin Order tray option can be invoked by menu (Orders and Trades → Admin order tray). The Admin Order Tray window is divided into two frames, one is “Pre-validation List” and another one is “Validated list”. In admin order tray also, initially when the order is placed, it goes to Put order state then once when the peer admin accepts it in his admin order tray the order will go open in this order (put order → open pending → open). The placed orders will go to the Admin-order-tray screen in Pre Validation List, where admin selects the orders and “Accept” or “Reject” it.
Once Admin validate the order it goes to "Validated List"

Now if admin has accepted the order it will go to the Order Book as an Open Order or else it will get rejected as the admin has rejected the order with the reason “rejected by GUI”.
The Open Orders will get triggered (Or complete) if the given conditions returns true value; which can be seen in either in Completed order frame in Order Book (F3) or in Trade Book (F8).

In Admin Order Tray it is necessary to peer with an admin or it will not go to the Admin Order tray, for that you have to go to Master menu → Entity Management → Entity Manager (Ctrl+Shift+E) and peer Admin. Once the peer has been done (e.g. Admin-Dealer), the admin will have the advantage to control the orders placed by the dealer.

18) **Order History:**

It returns the order history for the particular order number. Once the option selected following window will appear in which you have to give an order number you want to get the history for.
After giving the order number and click on “Ok” it will return the history along with all information viz. when it has placed, when it went for validation or modified, and how much the quantity traded etc. short cut is Shift+F12 has been assigned to it.

19) **Bulk Trades:**

Through this option user will come to know about the quantity he is going to place is how much percentage of the Issue Capital or how much quantity it will be for a given percentage of the issue capital. This may help him while placing the bulk order.
20) **Exercise/Delivery Book:**
Here user can view all placed exercise/delivery orders and modify/cancel them if they are open.

21) **Spread Order Report:**
Shows all placed spread orders. The orders can be modified or cancelled, or filtered.
22) **Partial Position Conversion Query:**
Here you will get the log for partial position conversion done if any.

23) **Modified Trades:**
All trades which have been modified will reflect in this dialog, so if you want to check whether the trade has modified or not you can check here.

24) **Order Slicing:**
Uses to slice an Order of big into multiple pieces, so that it can find the counter matches easily.
Order Slicing Window (Shift+S):
Once selected following window will appear in which you can select the scrip along with the exchange and the qty you want to slice, type of slice, no of slices and the price during the slicing and if you want to set a condition (Immediate or Market field value), once all fields set you can place the order to slice.

In Order slicing window, following slicing options are available:

i. Manual: If you have been selected the manual option, you have to fill the no of slice as well as qty per slice or else it will return you an error. Once you fill minimum required field you have to click on slice button, which will return you a confirmation window. If you want to slice the order click on “yes” it will slice the line according to the given instruction. After slicing you if you want to place the orders you have to “set condition” else it will return a pop-up saying, “please set condition to place selected order slices. If you select immediate you will get a confirmation window, click on “Ok” to proceed further. Your line will be placed with the slicing
and the open/completed orders can be seen in “Order Book” (and/or “Trade Book”). If you have selected **Market field Value** you have to fill some more information such as **Market fields**, on which basis the orders are about to sliced (LTP/Volume Traded Today/High/Low), Moreover you have to fill **If value** field, where you have to give the parameter (Less than or equal/grater than or equal/less than/grater than/equal) also you have to fill the **value** to place the order. If you have selected the option “**Confirm Before Place**” it will ask for the confirmation before trigger the order.

ii. **Market Volume**: The market volume option can be chosen if you want to slice the line with the market volume. You have to fill all the field including start and end time with the interval. Once it is done, the lines can be placed. And Open/completed orders can be seen in “Order Book” (and/or “Trade book”). You also can set the slice price while place in **Price Type**, whether it will be manual or based on ask/bid/ltp. After filling all the values you have to press the slice tab and your orders will get sliced.

iii. **Timer**: In timer you have to fill the start and end time for order execution. Once all done you have to press **Place** button to place the orders.

○ **Order Slice Book:**
In this window you will be able to see the trigger pending trigger complete and sliced detail. If want to cancel, you can press **Remove slice(s)**, Once it comes to **Trigger complete** frame it can be seen as open order in Order Book. The order can also be placed by selecting an order in Trigger pending book and then click on **Place Slices**.


- **Immediate Order Slice Dialog:**
  This option can be used to slice an order for a given price immediately (within no interval; which means it places all the orders at once after slicing), which can be seen in Order Book (if they are open/completed) and Trade Book (if traded).
Web Links:
Here you will set the web IDs/URLs you want to invoke if you are in NT.

Grouped orders

1) Grouped Order Book (Ctrl+Shift+G):
The placed Grouped Orders will be shown here along with the Basket Id, wave and line under it.

2) Simultaneous Orders (ctrl+Alt+S):
User can place two orders simultaneously by using this option. The dialog will appear once you click on it where you will be able to place two orders in any exchange and for any scrip.
Preferences

1) Hot Keys (Ctrl+H):
Hot Keys set for NT can be viewed here and changed if you feel it’s not convenient. As in the below dialog for Spread Basket Order assigned short cut key is Ctrl+Alt+C but you can change it into Shift+K or any other combination if you want so.

2) Tool Bar (Ctrl+T):
To view the Tool bar in the exe you can use this option, here you can find some tools as shortcuts which use very frequently in NT.
3) Message Bar (Ctrl+L):
Uses to invoke message bar along with the market watch where you will be able to get all messages. Following tabs are there in message bar;

- **Session**: It displays all messages which triggered during the session.

- **Dealer Ord/Trd**: It displays only orders related details placed by dealer.
- **News:** Displays only news for the session.
- **Misc:** Shows all other messages during session.

- **Messages:** Shows only Nest messages (viz. RMS related etc) for the session.

4) **User Settings (Ctrl+P):**

To change the appearance in different dialog you can use this option.

- **Appearance:** For all dialogs you can set the background and text color (and font) by using this option. Moreover here you can choose if the index color reflect the changes in color “Based on tick” or “Based on closing Price”
- Basket Order: The settings and alerts for Baskets can be changed here.
Event: settings can be changed for all events (Acknowledgement, Confirmation, Frozen, Cancellation, Trigger, Market, Rejection, and Completed) for Buy/Sell orders/Trades. The beep from internal or external speakers etc can be set here.
- General: All general viz. Exchange news if you want in log/pop-up or as flash window you can set and if you want to display the time which is same as exchange can be set here.
- Market Watch: This tab uses to change the market watch settings and appearance.
Snap Quote window if “Snap Quote Window” has been selected in Preference settings or if the option is selected from Menu.

Snap quote if “Market Depth Window” has been selected in preference settings.
Orders: This option can be used to change the orders settings and different prompts and alerts, focus etc.
o RMS: To change the RMS appearance (color) settings the option can be used.

5) Status Bar (Shift+T):
   Use to get the status bar in NT.

6) Tool Bar Settings:
   To change the tool bar options. If clicked, following window will open where you can change the settings.
7) *News Ticker Bar:*
To get the news ticker bar in the application this option can be used.
**Surveillance**

1) **RMS Limits:**
   The RMS Limits set, the margins utilized, collateral available etc. can be viewed in a comprehensive manner in the RMS Update Limits window. The user can also create customized columns, by specifying a formula for the calculation based on which the user-defined column will be represented.

RMS retrieves the orders and trades from the database when it comes up. Later it stores the same in its internal storage;

a- **View Limits (Ctrl+Shift+V):**

RMS View Menu is used for viewing the RMS limits of the:
- Broker
- Branch
- Dealer
- Client/Group
- Client

![RMS View Limits](image-url)
b- **Update Limits** *(short cut Ctrl+Shift+U):*

Add/Update Limits is used to set/update the limits for Branch, Dealer, Client group and Client. Once clicked following window will appear in which you have to select the entity for which you want to set or update the limit. Once you select that in list that client position will appear in the “present values” frame. If want to change/update or set new limit you have to double click on it. Moreover if any open position is there for that particular entity it will reflect in “Present Position” frame.
The Limits can be seen and update in the following window.
In case willing to see the multiplier and update them, you can click on the “Multiplier” tab. The hidden items will get appear and now click on “Update Multipliers”.

Once it clicked there on “Update Multiplier” following dialog will open on your screen; where you can modify the category and set/update rules for the particular group or dealer.
c- Rejected List (Ctrl+R):
It will return you the list of all the orders rejected as they have violated the set RMS rules. And can be update the RMS by holding the Ctrl key and double click on selected row.
d- Position Alert:
This option will return all current position along with the account Ids. Following prompt/alert beep are available for placed orders;
   i. Square Off Confirmation
   ii. Collateral square off
   iii. Confirm Message
   iv. Alert Beep

Few more options are here on this dialog
   I. Show History: This option returns all position alerts which have already taken place.
   II. Refresh: This option will refresh all the positions.
   III. Position Alert Square Off: This option will allow you to square off the selected position in the dialog. If check box “Sqr off Exact qty” on, you can square off the quantity is shown in position window.

e- RMS Surveillance Screen:
It returns all the account Ids along with their present values in different category.

2) Category:
Here you can assign a category or modify or just view the category created for.
   a- Add Category (Shift+Alt+Y)
   b- Modify Category (Shift+Alt+M)
   c- View Category (Shift+Alt+V)
3) Holdings:
You can view your holdings here or update that and the Haircut for the scrip can be set.

   a- View Holdings/Collateral Values (Alt+F9): Once selected a window will appear where you can select the account id to check his holdings, and can be squared off.

   If right click you will get the options 1- NSE Holding sqr Off, and; 2- BSE Holding sqr Off.

   b- Update Holdings/Collateral Values(Ctrl+F9): Holdings can be updated here.
c- Scrip Wise Haircut: The haircut can be set here for all scrip present in NSE as well as BSE or preset Haircut can get using the tab “Get” moreover the preset values can be “reset” here.

4) T1 Holdings
   a- View T1 Holdings: The holdings for a particular client can be viewed here.
b- Update T1 Holdings: holdings can be updated using this option.
5) Scrip Margin:
The margin for particular scrip can be set using this option, you have to set broker as well client position limit. If the limit reaches up to the level it returns an alert prompt. Shift+M is assigned as short cut to invoke the dialog.

6) RMS Ban Symbols:
As NSE exchange stipulates Market wide limits for derivatives contracts; when these limits are breached, such symbols are banned for any entity for taking fresh positions in that symbol, wherein only squaring off of positions is allowed.

a- FO Banned symbols:
The broker can ensure that orders are not placed in such banned symbols for taking fresh positions and only square off orders are allowed, by adding those symbols in the ‘RMS Ban Symbols’ list. This can be done on a Global level or on a Broker level.
7) **Scrip Basket:**
You can get the basket of scrips which follow the RMS rules, new baskets can be created or the old ones can be modified or deleted, or the basket can be assigned to particular category or you can get the category assigned for a particular basket through following options.
   a- Add Scrip Basket
   b- Modify Scrip Basket
   c- Delete Scrip Basket
   d- Assign Scrip Basket
   e- Get Scrip Basket

8) **Scrip Group:**
It returns the rule applied on particular group, the category can be modified here, you can add new group too and set new rules or modify for the existing ones.
9) Restricted Scrip Basket:
   The basket can be created here which are restricted for trading until they have
certain margin available in account. Following options are available in under this;
   a- Add Restricted Basket
   b- Modify Restricted Basket
   c- Delete Restricted Basket
   d- Assign Restricted Basket
   e- Get Restricted Basket

10) NRI Scrip Basket:
The NRI basket can be created through update or viewed by the option “view NRI
Scrip Basket”
   a- View NRI Scrip Basket
   b- Update NRI Scrip Basket
11) RMS Blocking:
Here you can block Broker/branch/dealer/client group/client to place the fresh orders.

a- Block/unblock Orders:
Here you can block Broker/branch/dealer/client group/client to place the fresh orders for a particular scrip or scrip group for a product and the block type (Intraday-sqroff/Non-sqr off/sqr off), even a category can be blocked/unblocked. Short cut Ctrl+F10.
b- Block/Unblock Spread Orders:
This can be used to block/unblock spread/2L/3L orders.

12) Auto Square Off Exclusion List:
This option will allow excluding the clients from the auto square off for different market.
   a- Auto Square Off Exclusion List (For Cash )
   b- Auto Square Off Exclusion List (For Derivative)
   c- Auto Square Off Exclusion List (For Commodity)
13) **Execute Auto Square Off:**
This option will allow you to execute auto square off for particular product viz. Cover Order.

14) **Admin Square Off:**
You will be able to square off the position for selected clients for particular scrip.
15) Place AM Orders:
You can place the AM orders (After Market orders) using this option. The option is available to place the AM orders for selected exchange.

16) Start storing AM Orders:
If chosen this option NT will start storing the placed AM orders.

17) Stop storing AM Orders:
To stop storing the AM orders you can use this option.
1) **Entity Management:**

The Entity management option under Masters Menu allows you to add/view or modify different entities.

- **Entity Manager (Ctrl+Shift+E):**
  
  Once selected following window will appear in which you can add different entities and modify them according to their need. You can filter them using Ctrl+F. In this window you will be able to see the Entity Hierarchy in the left side if want you can invoke the details of selected entity by double clicking on it.

- **Add Branch (Alt+Shift+B):**
  
  Use to add new branch. You have to fill the branch Id, location along with a name in following window to create a branch, once filled all details click on “Add Branch” to create new one.
c- Add Dealer (Alt+Shift+L):
Use to add new dealer in the branch. In general tab you have to fill all fields marked with the asterisk sign and in details tab select the product, access type and Order type you want to assign. In Assign Clients tab you have to select the clients you want to assign to that dealer whereas in Attributes tab you should assign some attribute to him which you want to provide him.
You can select the attributes and Nest Action for that particular attribute.
d- Add Client (Alt+Shift+C):
You can add new client using this option. In “General” tab four types of clients can be added in NT; Foreign national, institutional, non-institutional and NRI and the status can be assigned to them whether they are activated, deactivated, squared off or suspended and if they are offline or using the internet for NT. In “Bank info” tab they have to add their bank name and details and DP Info is about their DP related information whereas RMS limits can be set in “Set RMS Limits” tab.
e- Add Investor Client (Alt+Shift+I):
Option can be used to add an Investor client in the hierarchy. Once clicked following window will appear where you have to fill all required information in all tabs (in General all general information, in contact his contact related information, in Bank all bank related details, in depository his DP related information, in Exchange which all exchanges are assigned to him for trading, in RMS the RMS rules applied on his account and in attributes attribute assigned to him in Nest)
2) Refresh Entity Hierarchy:
This option is used to refresh the hierarchy in NT.

3) Admin Position (F11):
   The admin position can be viewed by selecting this option. This option leads you to the following window where the admin will be able to know all the position taken by the users or clients under them.
   The option can be selected if you want daywise/netwise positions; Enable position is there to help you to get the position of all users under you whereas the position conversion is there to change the product type form one to another. The selected position can be squared off here (either long or short or both) if check box square off exact qty is on the certain qty of the selected position can be squared off else it takes the qty in % of the total one. In the status bar, quantities and values changes accordingly.
4) Client Wise Position (Alt+F11):
   This can be used to display the client wise position; the position can be filtered segment wise and client wise.

5) Report Generator:
   Use to generate trade/order reports for different entities.
   a- Format Editor (Alt+Shift+E):
   This option is use to change the report format or add a user defined field in the report. You can save the format and use the same for the report you are generating.
b- View Report (Ctrl+Shift+R):
This option is there to generate the report. You have to select whether you are generating order or trade report and specify the format you want the report to be generated in along with the date and file path where you want to save the report.
c- **Generate Dealer Report**: Use to generate Dealer Report

d- **Generate Client Report**: Use to generate Client Report

e- **Generate Investor Client Report**: To generate Investor Client Report

6) **Role Manager**:
   It can be used to add/modify the roles assigned to different users.
   a- **Add**: New Roles can be added with the help of this option.
   b- **Modify**: To modify the exist role.
   c- **View Roles**: To view the role assigned.
   d- **Delete Roles**: Delete the defined role.

![Add New Role - SHWETA-OTPUAT](image)

7) **Display Logged In users**:
   To view the logged in users you can use this. It will display all logged in users and if you double click (or click on “Details” tab after selecting the user) on any of them the details will display in the “User Details” frame. You can make the user logout by using clicking on the tab “Log Out User”.

[Diagram of role management interface]
8) Display Subscriptions:

The subscription of scrips is an option in Nest Trader which is used to restrict users to subscribe certain no of scrips per session. If user wants to see subscribed scrips he/see can go to option Display Subscription which is under Masters Menu. This window will show the subscribed scrip only for the selected market watch, to check for the other market watch user has to go to that market watch and again select the option “View subscription”. It will return the subscribed scrips for selected market watch when the Refresh tab is clicked. The non-subscribed scrips will be in Red color whereas the subscribed scrips will be in Green color.
9) Search/Activate Entity (Ctrl+E):
This option allows you to search an entity and if it is inactive you can add the same. Following window will appear if clicked;
10) **Action Right:**
Displays what all action rights have been assigned to you.

**Tools**

1) **Option Calculator (Shift+O):**
Option calculator can be used to check the selected option contract value at that time. Once it clicked there following dialog will come on your screen. User has to give all related information viz. expiry date, option type, strike price, input values, volatility and interest rate etc. to get the Option Greeks values.

![Option Calculator](image)

2) **Position Analysis (Shift+Alt+P):**
Use to analyze the open positions at a certain point of time.
Various options are available for the user by just right clicking the Position Analysis screen. These options are listed as follows:

a- Implied Volatility:
Once this option has been selected a small window will appear in which Implied Volatility can be seen for the Future and Cash for a selected scrip in Position Analysis window Implied Volatility window can also be invoked using shortcut key F5.

b- Implied Volatility Graph:
This option provides a real time graph for the selected contract. By default it will show the graph for call as well as put option that keeps on changing on real time basis.

c- Buy Order (F1): To invoke Buy Order Entry dialog.

d- Sell Order (F2): Normal Sell Order Entry dialog can be invoked using this option.

e- Order Book (F3): To invoke Order book you can use this option.

f- Trade Book (F8): The Trade Book can be invoked using this option.

g- Snap Quote (F6): market depth/snap quote window can be invoked by this option.

h- Refresh Position:
To refresh the positions in a Position Analysis window this option can be used. The “Space” key is assigned as shortcut for refreshing the positions

i- Delete Position:
It is used to delete the position from the screen. User can press “Delete” to do the same.

j- Scenario Analysis:
Using Scenario Analysis option, a user will be able to analyze his/her option positions under different scenarios. User just needs to enter the price band (high and low) along with the intervals, and the Scenario Analysis will automatically calculate the Max Profit, Max Loss, Bep1, and Bep2, for that price band.
Once the foresaid list is entered in the Scenario Analysis window, following options are available to the user for further analysis:

- **View Pay off**: View Pay-Off option allows user check various payoffs at different price range for a selected contract. If user has only one position in the Position Analysis Window, it will show only stock price with possible profit/loss for that position in a given interval whereas if there is more than one option positions present in the Position Analysis Window, it will show the combined pay-offs along with the individual pay-offs for each option contract present in the Position Analysis Window.

The graph for the retrieved data can be plotted with the help of given tab “Plot Graph”. Once user clicks on it, all four individual pay-offs along with the combined pay-off is plotted on to the screen.
• **View Sensitivity:** This option allows user to check the sensitivity of the selected option contract. User needs to enter the asset price range between which it can be moved. There are three options available to check the sensitivity of an asset. These are:
  a. Date Range
  b. Risk free interest Rate
  c. Volatility

  You will get the pay-off for each option and can draw the Pay-off Graph if selected.

k- Reflect Volatility For selection:
This option will return the volatility for the selected option contract, which can be seen in the volatility column in the selected contract row.

4) **Option Strategy:**
In case you are not able to create your own strategy over options, here we help you through this option. All you have to do is just select if you are bullish/bearish/neutral for selected option contract. NT will suggest some options if you feel you can choose one among them. It will calculate all Greeks and Portfolio data as well.
You can add them in your portfolio/view sensitivity or pay-offs for the same.

5) What If Analysis (Shift+W):

The option allows you to check how much margin required to buy/sell particular scrip for a particular client or how the account will be affected by buying/selling a scrip.
7) Messaging (Ctrl+Shift+M):
The messages can be sent to different users with the help of this option. The message can be sent to online users only. The sent message can be seen in log window and “Messages” tab as well.

8) Set Alert:
You can set the alerts for the index as well as for security touching a specified level. Whenever the index or scrip meets the condition specified in the alert it gets triggered, and return a pop-up/E-mail or a SMS.
9) Alert List:

It returns the alert list which are set but not yet triggered. The alerts can be modified or cancel here.

![Alert List](image-url)
10) Set Order Alert:
The Order alert can be set, it will return a pop-up as soon the alert get triggered. The order alert can be set if the order status is Cancellation/Complete/Rejected/Traded/Trigger. You have to select an open order no for which you want to set the alert and once the given condition is true, it returns a pop-up or mail.

11) Order Alert List:
Allows viewing all Order Alerts; which have not been triggered yet. You can modify/cancel the alert here.
12) Lot Converter:
The option helps you to change the quantity into lots for scrip.

13) Offline Portfolio (Ctrl+Alt+P):
It helps you to create a portfolio and checkout if it is beneficial for you. It shows MtoM as well as current value of asset.
Another tab in Offline portfolio is “Transaction History”, which allows you to view the history of offline portfolio; it shows you the overall gain along with the transaction record.

In status bar you will be able to see total qty of assets along with total investment and MtoM value.

14) Calculator: To invoke Calculator.
15) Dollar to Rupee Converter:
It helps you to convert your dollar into Rupees with a given rate.

![Currency Converter](image-url)

**End of the Document**